




















HOW TO READ THIS MANUAL 

Throughout this manual we will use the following ways of representing information: 
MENU COMMANDS will be CAPITALIZED. 
Example: SAVE, RESTORE, QUIT, PAUSE GAME 
Typed commands will appear as bold type. . 
Example: 'type: [example game command]' 

. ' type: cd \sierra' 
Portions of the c·ommand line not meant to be typed will not appear in bold type. For 
example, in the line ' type: cd \sierra' : 'type:' should hot be typed. . 
[EXAMPLE TEXT] and [Keystrokes] will appear in brackets setting them off from the 
surrounding text. 
Example: OF GAME] [NAME OF D.QlliCTORY] [Spacebar], [Tab], [Page­
Up] 
The brack.ets are not keystrokes and should not be typed. 
Two or mQre keys that should be pressed at same time will be segarated oy a hyphen 
(-). This hyphen is not keysttoke, and should not be ryped. 
Example: 'Press [Ctrl-I] to view your inventory.' 
If a space appears between parts of a command, ir is meant to be typed. 
pxample: ' type cd \sierra' (the space between cd and \sierra s.hould be typed as part 
of the command) _ 
The term 'diskette ' is used to refer to either 3.5" or 5.25" data storage disks. 

AI::L SYSTEMS 
PLEASE NOTE: If there is a README file on your game diskette. It may contain 
important information and instructions that were not available at the time the 
documentation and other materials for this game were printed .. Failure to review the 
README file before installing the program may cause unexpected results during 
installation, loading or playing the game. ' 

MS-DOS README INSTRUCTIONS 
From DOS, type readme to see the README file onscreen. Use [PageUp ]/[PageDown] 
keys to scroll through the file. 

. AT ARI ST README INSTRUCTIONS 
To view the README file from {he desktop, double-click on the README. DOC icon. 
You will see a messllge box with choices· for SHOW, PRINT, and CANCEL. Choose ' 
SHOW to view the file onscreen one page at a time. Press [ENTER] to see the next 
screen. Choose PRINT to print' the file. Choose CANCEL to escape the message box. 

AMIGA README INSTRUCTIONS· 
Insert Workbench disk into drive DFO: and turn on.your system. Double click on the CLI 
icon. 
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Users with one drive: Copy the TYPE co"ffimand into your RAM disk. See your 
Amiga owner's manual for instructions. Insert Disk 1. Type: type readme. 
Users with more than one drive: Insert Workbench in drive DFO:. Insert Disk 1 in' 
drive DFI :' ,Type cd dfl:. Type: type readme. 

GETTING STARTED: DISKETTE DRIVES 
It is alway's advisable to make back-up copies of your master program diskettes to 
increas'e the life of the masters and guard against accidents. Follow your computer's 
instructions to make copies of all game diskettes. I 

Even if you will be playing from a hard disk, you may want to format a blank diskette 
for saving games. In/act, saving games to diskettes is a good idea, even if you a;'e playing 
the game from your hard disk. Follow your computer's instructions to format a blank 

and keep it saving your,game you play. ,For) some helpful tips on 
savmg games, see the Savmg Your Game (Page 24) section of this manual. 

YQur program, you may be prompted to insert a 'Drivers ' disk. If you 
receive thiS prompt, please examine your disks and insert the disk marked 'Drivers' and 
press [ENTER], so that the appropriate drivers will be loaded. Some games do not include 
a separate ' Drivers' disk. 

MS·DOS 
INSTALL THE GAME 
Place the back-up copy you have made of Disk 1 into your diskette drive. Type the letter 
of the disk drive you have placed the disk into followed by a colon (for example: a:) ; 
and press [ENTER]. Type: install and press [ENTER] . , 

the onscreen questions using the up and down [Arrow] keys to highlight your 
selectlOns, then press [ENTER] to select. You wi!! be asked if you wish to install the 

. game on your hard disk. If you do not wish the game .to be installed on your hard disk, 
press [ESC] to skip this step. If you want to install the game on your hard disk, enter the 
letter designation of your hard disk (usually C) and follow the prompts. . 
PLEASE NOTE: Even if you install to a hard disk, the install procedure will write ii 
file named RESOURCE.CFG.to Disk}. For the installation to be completed correctly, 
DISK 1 MUST NOT. BE; 'WRITE PROTECTED. No other files on Disk 1 are written 
or changed by the install command. 

LOADING INSTRUCTIONS 
After c,ompleting the INSTALL procedure: 
From diskettes: 
1. Place Disk 1 into the A: drive. 
2. Type: a : and press [ENTER]. 
3. Type: sierra and press [ENTER]. 
From ·hard disk: 

.1. From your root directory, type cd \sierra and press [ENTER]. 
2. Type [SPECIFIC and press [ENTEFl 
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SA VING GAMES TO DISKETTES 
PLEASE NOTE: If you're playingfrom diskettes, you must have a separate formatted 
diskette ready before you can save a game. We also recommend that you create several 
directories on your save game disk in order to assure adequate space for save 'game 
storage. 
Choose SAVE GAME from the File menu or press the [F5] key. The Save Game menu 
will appear. , 
Use your [Tab] key to choose CHANGE DIRECTORY. Backspace or press [Ctrl-C] to 
clear the command line. 
Type the letter of the drive you are ~sing for saved games, followed by a colon (Example: 
a:) and press [ENTER]. , . . 
Type the name of your saved game and press [ENTER] to complete the SAVE GAME _ 
procedure. If your disk for saving games is full, you may reformat it (this will erase the 
saved games on the disk) and use it over, or use another formatted blank disk. 

SA VING GAMES TO HARD DISK • 
If you choose to savs 'games to the hard disk, the program will automatically try to save 
to the game's own directory. If you run out of space for saving games, try one of the 
following alternatives; 
Save additional games to a diskette. 
Save games to a different directory by choosing CHANGE DIRECTORY. from the 

: SAVE GAME menu (inside th.e game). 
Create a new hard disk directory from DOS, using DOS instructions. Delete all saved 
games and the saved game directory from your hard disk by following DOS instruc­
tions (outside the game). The program will create a new index file within the game 
directory. 

ATARIST 
LOADING INSTRUCTIONS 
Note: If you are using an Atari 52Q ST without memory expansion, turn off all desk 
accessories (rename .ACC extension .ACX) before running your Sierra game. 
1. If you are playing the game from diskettes: Place Disk I in drive A, and open the 
disk by double-clicking on its icon. Start the game by double clicking on SIER­
RA.PRG. 
2. If you are playing the game from a hard disk: Open the disk by d<;mble-clicking on 
its icon, then open the game folder by double-clicking on the game folder icon. Start • • 
the game by double-clicking on SIERRA.PRG 

HARD DISK INSTALLATION 
Please note: More than 5I2K of memory is needed in order to run Sierra games on you 
ST If you have a hard disk. 
1. Open the hard disk by double-clicking on its icon. 
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2. Create a game folder by choosing NEW FOLDER ... from the File menu. Open the 
new folder by double-clicking on its icon. 
3. Place Disk 1 in drive A. 
4. Copy the game disk into the new gam~ folder by dragging the drive A icon,into the 
window you opened in Step 3. 
5. Repeat steps 3 and 4 for each of the other game disks. 
6~ Put the master disks away in a safe place. 

CHOOSE A MUSIC DEVICE (Optional) 
Your Sierra game is initially set up to play music and sounds through the Atari ST's 
internal speaker. If you have one of the supported MIDI synthesizers, you may run the 
MUSIC program to have the game play music through the synthesizer. 
1. Open the game disk/folder by double-clicking on its icon. 
2. Run the MUSIC program by double-clicking on the MUSIC.PRG icon. 
3. Select MUSIC DEVICE from the Options menu. , 
4. Select your synthesizer (or 'Atari ST Internal SQund ') by clicking on the ap-
propriate button. Then click on OK. _ 
5. Select INSTALL GAME from the File menu. This will replace the 
RESOURCE.CFG file on your disk. 
Please note: It is important to tum your synthesizer on before starting the game. 

AMIGA 
INSTALLING THE GAME 
NOTE: RENAME your copies of aU game disks to remove the words 'COPY OF' from 
the disk name. If the words 'COPY OF' are not removedfrom the disk -names of ALL 
the copies, the system will continue to ask for the original disk, {l1ld will not run the 
game. . 
1. Boot your system with Workbench, and. insert Disk I of your Sierra game. 
2. Double-click on the disk icon, then double-click on the INSTALL icon. _ . 
3. Follow the onscreen prompts, choosing your selection with the mouse by clicking 
once on the item: 
4. You will be asked if you wish to install the game on your h'ard disk. If you do not 
wish the game to be installed on your hard disk, select NO. If you want to install the 
game on your hard disk, select YES. 
5. Using your mouse, select the drive on which you wish to install the game. 
6. Follow the onscreen prompts to complete the installation. 

LOADING INSTRUCTIONS 
From Diskettes: . 
1. If you have less than I megabyte of memory for your Amiga, tum your system off 
and disconnect any external drives. 
2. Insert Disk 1 into drive DFO:. 
3. Tum on your system. 
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From Hard Disk: 
1. Load Workbench and double-click on your hard disk icon . . 
2. Double-click on the SIERRA GAMES drawer. 
3. Click on the drawer for the desired Sierra game. 
4. Click on the game icon. 

ALL SYSTEMS 
MOVING YOUR CHARACTER 

. You'may move your character on the screen with the [Arrow] keys, the numeric keypad, 
the joystick, or the mouse. To halt your character's' steps with the keypad, press the 
number 5, or press the last used direction key again. Do nut attempt to move the 
character by holding down the direcjion key. This will cause the character to start 
and stop continuously, resulting in very slow progress. . 
Using the. mouse, position the arrow where you want the character to move, then click 
the left mouse button (if your m~)Use has multiple buttons). 

, t ,/ 

rr7l is ' r9 

- 4 rs Is . 
STOP .--

fl ' 1r2 r3 

MENUS 
When you press [ESC], a menu bar will appear at the top of your screen with several 
menus that can be opened to show the' command ~hoices available to you. 

KEYS TO USE IN THE MENUS 
Use the left and right [Arrow] keys to open a menu, and the up and down [Arrow] keys 
to highlight items within a menu. 
Press [ENTER] to select a highlighted command. . 
Press [ESC] to return to the game without choosing a command. 

GAME SPEED CONTROL 
At times it may be useful to slow down the speed of the game animation in order to 
negotiate a tricky section, or observe something more carefully. At other times, you may 
wish to speed up the game actions. To increase or decrease animation speed, choose 
FASTER or SLOWER from the Speed Menu, or use the [+] I,<ey to increase speed, the 
[-] key ~o decrease 'speed, or the [=] key to return to normal animation spe~d. I 
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SHORT CUTS FOR COMMON COMMANDS 
You can use function and concrol keys to short cut·many common commands. 
[Fl] Help - . 
[F21 Toggle sound on/off 
[F3], [Spacebar] Repeat previous command 
[FS] Save Game 
[F7] Restore (saved) Game 
[F9] Restart Game (from beginning) 
[Tab] Inventory 
[Ctrl-I] Inventory 
[Ctrl-P] Pause Game 
[Ctrl-Q] . Quit Game 
[+ ] Increase Animation Speed 
[-] . D~crease Animation Speed 
[=] Normal Animation Speed 
[Ctrl-V] Change Volume 

USING YOUR"T AB KEY 
While playing Sierra games, your [Tab] key will perform two major functions. You will 
use it to review the items in your inventory, and also (if you're nol using a mouse) to 
select options from certain menus. The following menus will require the use of the [Tab] 
key for highlig,hting menu options: 

Menu ............ ... ...... : ..... .. ..... . Choose from 
Restart Game ...................... . Restart, Continue 
Quit Game ........................... Quit, Don't Quit 
Save Game .......................... Save, Cancel, Change Directory, Replace 
Restore Game ............ .. .... 1 ... Restore, Cancel, Change Directory 
[Deat~ Message Box]. ......... Restore, Restart, Quit 

USING THE MOUSE (optional) , 
To ,move your ch_aracter using ~he mouse, pOSition the arrow to where you want the 
character to move, then click the left mouse button. 

RETYPING COMMANDS 
If you wish to repeat a command select RETYPE from the ACTfON menu or press the 
[SPACEBAR] or [F3]. . . . 

, 
INVENTORY 
If you wish to see the items you are carrying, select INVENTORY from the Action menu, 
press [Ctrl-I], or press the [Tab] key. A list of the items you are carrying will be displayed. 
To look more closely at an item, use your [Arrow] keys to highlight the item and press 
[ENTER]. A picture of the item, along with a brief description, will 'appear on your 
screen. Press [ENTER] Qr [ESC] to resume play. 
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PAUSING YOUR GAME 
If you wish to pause the game, select PAUSE from the Action menu ~ or press ICtrl-P] . 
Press [ESC] or [ENTER] to resume play. 

SA VING YOUR GAME 
If you ~ish to save your game, select SA VE from the File menu, or press [F5]. To allow 
for errors in ju4gement and creative exploration, we recommend that y~:)U frequently save 
your game in progress, and that you save several different games from different points 
as you play. You will always want to save your game before encountering potentially 
dangerous situations. You should also save your game after you have made significant 
progress. ' 
Please note: If you're playing from diskettes, you must have a separate formatted 
diskette ready before you can save a game. Since each disk can only hold a limited 
number of games, we recomme.nd that you have more than one disk formatted, in 
order to assure adequate space for save game storage. 
If you' choose to save games to your hard disk, we suggest that you create one or more 
save game directories or folders on your hard disk. See your computer's instructions for 
creating directories or folders. You may name· your saved games using standard English 
phrases. For example, if you are standing on a sandy beach, you might call your game 
'standing on sandy beach' , or simply 'beach'. 

RESTORING YOUR GAME-
Select RESTORE from the File menu, or press [F7). You will be prompted to select the 
.,game you wish to restore. (On a single drive system, you will be prompted to insert your 
save game disk). Highlight the desired game and select RESTORE. If the game you wish 
to restore is in a different directory, select CHANGE DIRECTORY. 
Please note: If you do not have a mouse, use the [Tab] key to toggle between RESTORE 
and CHANGE DIRECTORY. 

QUITTING'YOUR GAME 
To stop playing, select QUIT from the File menu, or press [Ctrl-Q). 

RESTARTING YOUR GAME 
If you wish to restart your game at, any time during play, select REST ART fro!TI the file, 
menu, or press the [F9] key, The game will begin again-(INSERT GAME SPECIFIC 
INFORMATION). 

COMMUNICATING WITH'CODENAME: ICEMAN 
You can generally interact with the game by typing simple commands consisting of 
as little as a noun and a verb: For instance, the command sit in the chair can be shortened 
to sit in chair, or even sit. Unless otherwise directed, follow all typed commands with 
[ENTER] 
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Many characters in the game will have information of one kind or another for you. To 
talk with a character, type: talk to [character] (for example: talk to man). 
You may encounter objects you need along the way. To take an object, type: take or get 
[object]. For example, take the note. You will need to use the objects you acquire as 
you explore. You can try different things such as typing:' use the [object], or give the 
[object] to [charact~r]. Different apPloaches to a puzzle may bring about a different 
outcome. 
Pay close attention to details. To examine objects, type look at the [object] , (for example: 
look at the table), or press [Ctrl-L], then type the name of the object. 
To get a general description of the current room or scene, type look around, or use your 

, mouse to choose LOOK from the menu. 
A message window will appear after you enter,each command, and at other times during 

, the game. When you have read the message, press [ENTER] to remove the window and 
'resume play: . ' 
Coden arne Iceman understands many common verbs. Here are some you might try: 

ASK DROP SEARCH TELL ' 
BUY EAT PLAY SIT 
THROW · CLIMB ' GET PUSH-
TAKE • USE CLOSE GIVE 
READ STAND WALK DRINK 
OPEN RUN 

LOOK everywhere. Thoroughly explore your surroundings'. Open doors and drawers, 
look under things and behind things for valuable objects and clues. Look closely at all 
objects you encounter or you may miss important details. 

EXPLORE each area of the game very carefully. Search every area of the g,ame. Be 
careful!! There are many hazards awaiting you! 

DRAW A MAP as you progress through the game. Make a note of each area you visit, 
and include information about objects found there and dangerous areas nearby. If you 
miss an area, you may miss 1m important clue! 

GET objects you think you will need'. You will come across a number of objects that 
may be of use to you later. You can see an inventory of items on hand by pressing the 
[Tab] key at any time. 

USE the items you have picked up to solve problems in the game, or to help you to make 
progress 'and discover more clues. ' 

BE CAREF.UL, and remain alert at all times - disaster may strike in the most unlikely 
of places. 
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SAVE YOUR GAME OFTEN, especially when you are about to try s,?mething new 
or potentially dangerous~ This way, if the worst should happen: you won't have to start 
all over again from the beginning. Save games at different pomts. of t?e game, so you 
will be able to return to a desired point in the game. In effect, thIS WIll enable you to 
travel backward through time and do things differently if you wish. 

DON'T GET DISCOURAGED. If you come to aI! obstacle that seems insurmountable, 
don't despair. Spend some. time exploring another area, and come back ,later. E,very 
problem in the game has at le~st one solution, and some have more than one. ~om~tIm~s 
solving a problem one way will make it harder to solve the next, and sometimes It Will 
make it easier. If you get stuck, you might try backtracking to .an earlier point in the 
game, then choosing a different path. If all else fails, you cal! buy the [Name O/Game] 
hint book from the dealer who sold you the game, or you-can order it directly from Sierra 
On-Line by calling (800) 326-6654. 

BRING ALONG SOME HELP. You may find it helpful (and fun) to play the game 
with a friend. Two (or more) heads are better than one at interpreting clues and solv­
ing problems 

NEW FEATURES' 

Note: Codename: ICEMAN features a new and improved playing system for easy in­
terface. Here are some of the improvements we think-you'll appreciate: 

1. LOOK - If you simply type look in any .room, you'll automatically get a descrip­
tion of the object(s) directly in front of your character. If you type look at [person] or 
[object] and your character is not facing that person or object, you,r c,haracter will 
tum to face the persqn.or object before thegame-gives you a descnptlon. 

2. GET, TALK, TAKE, {COMMANDS OTHER THAN 'LOOK') - In some 
cases, you may 'want-to talk to a person or get an object that is not directly in front of 
you. Previously, the game might have responded by saying 'You're not close 
enough'. With ICEMA~'s improved playing system, ifyou~ character isn'~ cl~se 
enough, he'll automatically move closer to the person or object before gettmg It or 
talking to him/her. -

3. DOORS - Most doors in the game will open automatically when your character ap­
proaches thein. This eliminates repeatedly typing open door. 

- 4. MOVING YOUR CHARACTER - To easily walk to a visible point on your 
screen, type walk to [object]. Your character will automatically make his way t~ the 
desired point. Moving your character is generally easier with the improved plaYing 
system. 
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NEED A HINT? . , ..' 
If you find yourself 'a little stuck' while playi~g a Sierra ~ame, try the follOWing Ideas: 
1. If you have a modem, you can talk to the SIerra Bulletin Board through the follow-
ing number: , 

(209) 683-4463 
Our settings are 300: 1200 or 2400 Baud; 8 Data; N Parity; 1 Stop Bit. Our sysop 
will be happy to help you. , -
2. Many other bulletin boards also provide hints to many of our g~es. , 
A. CompuServe: Go in~o the Garners Forum (GO GAMERS) or wnte E-MaIl to 
76004,2143. . 
B. Prodigy: Write E-Mail to 'HTWS90E', or go to the PC Club and enter the adven- . 
ture games forum (Jumpword: PC CLUB). , ' , 
C. PCLink: Select PCLink Plus, enter Publisher's Con~ectlOn, select PublIshers. 
Forums, then Sierra On-Line. E-Mail may be written to the User ID 'SierraOnLI'. 
D. America's On-Line: Select the KEYWORD option from the 'Goto' menu, and 
type: Sie~ra: E-Mail may also be written to the User ID 'Sierras'. 
E. GEnie: From the main menu select 10 (Games), then select 1'(Games Round 
Table). Select 1 (Games Bulletin Board), and type set 22 at the '?' prompt. Th}s. will 
take you into the Sierra On-Line area. , . ' 
For more information on these BBS lines, you can call these toll-free numbers: 

CompuServe (800) 848-8199 
Pr~gy(800)822-6922 
PCLink (800) 458-8532 ~ 

GEnie (800) 638-9636 , 
3. The magazine Questbuster's Journal is a helpful source of many game hints. 
'4. Your 10ca1.software dealer may carry olir hint books, or may be willing to order 
them for you. " ' 
5. If you are unable to obtain a hint book through a dea)er, you can order one drrectly 
from..us. Call (800) 326-6654 to place your-order with a Visa, MasterCard or 
American Express card, or write Sierra On-Line Inc. , Order Department, P.O. Box 
485, Coarsegold, CA 93614. • . , 
6. If the hint book is not yet available for the game you are plaYing, call our 
automated hint line at (900) 370-KLUE to receive a' hint. NOTE: California resi­
dents, please dial (900) 370-5113. 

TIDS SERVICE IS AVAILABLE 24 HOURS A DAY. THE CHARGES ARE: 75 
CENTS FOR THE' FIRST MINUTE AND 50 CENTS FOR EACH ADDITIONAL 
MINUTE. IF YOU ARE UNDER '18 YEARS OF AGE, YOU MUST HAVE A 
PARENT'S PERMISSION TO CALL. THE CONTENTS OF ALL MESSAGES 
ARE SOLELY THE RESPONSIBILITY OF SIERRA ON-LINE. HINTS WILL 
NOT BE GIVEN ON OTHER SIERRA TELEPHONE LINES. 
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PROBLEM DISK? 
TECHNICAL HELP (MS DOS ONLY) 
If you are having problems with a game disk, try these suggestions before assuming the 
disk is faulty : ' . 
If you receive any of the following messages: 
1. 'Insert Disk (#) ' when you have already inserted that diskette, or have installed the 
game on your hard disk · . ' 
2. 'Out of Handles' or 'Olit of Heap ', or if the game locks up at any point 
3. 'Disk Error' 
Then you may have memory resident programs loaded into your RAM memory. You 
will need to boot your system from a diskette containing your operating system only. 
Follow these instructions to create a 'Sierra Boot Disk'. I 

First format a blank disk with DOS ~ystem files (using Is) to make a bootable disk: 

FORMATTING FROM A HARD DRIVE 
A) Place a blank disk in drive a: 
B) At the C prompt, type: format a:/s 
NOTE: If your A: drive is a high density drive and you are using double density disks , 
you will need to type: format-a:/4/s (for 5.25" disks) 
or type: format a:/n:9/s (for 3.5" disks) 

FORMATTING FROM A DISKETTE DRIVE ' 
A) Place your original DOS disk in drive A. 
U) At the A prompt, type: format a:/s (be sure to switch to a blank disk when 
prompted by the FORMAT program.) , 
NOTE: If your A: drive is a hig'h density drive and you are using double density 
disks, you will need to type: format a:/4/s (for 5.25" disks) . 
or type: format a:/n:9/s (for 3.5" disks) 
C) Press [ENTER] 
D) Respond to DOS prompts. 
Now you should create a CONFIG.SYS file on your Sierra Boot Disk, with a files=20 
statement. Follow these instructions to create this file: 
A) Type: a: [ENTER] 
B) Type: copy con config.sys [ENTER] 
C) Type: files=20 [ENTER] 
D) Press [F6] [ENTER] 
You should see the message: ' 1 File(s) copied ' . YO}! will now have to re-boot your 
computer with your new Si,erra ~oot Disk in the drive. Tum your computer off then on, 
or press [Ctrl-Alt-Del]. I 

If this ,does not clear th.e above messages, call (209) 683-8989 for technical help. Our 
technical staff will be happy to help you. 

28 

TECHNICAL HELP (ALL SYSTEMS) . 
Technical assistance.i.s only a telephone call away. Call (209) 683-8989 for convenient 
person-to-pe~son servi~e, or if you prefer, you may request assistance by mail. If yo~ 
choose to ,wnte to us wltllyour request, please state your computer type ancl the nature 
of your problem. ' 
If you find that you need to send for replacement diskettes, send the original disk 1 in 
the size you need (3.5" or 5.25") to: 

Sierra On-Line 
P.O. Box 485 
Coarsegold, CA 93614 
Attention: RETURNS 

Be sure to include a note stating your computer type, and the size of diskette you need 
(5.25" or 3.5"). ' . -
We will 'gladly replace your program free of charge for the first 90 days of ownership 
~please enclose a coPy of ~o~r dated sales receipt with your request). After 90 days there 
IS a $5.00 charge for 5.25 diskettes, and a $10.00 charge for 3.5" diskettes. 
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WALKTHROUGH 
WARNING! The following section includes hints that 

experienced gaI?e player~ may not want to see. Continue reading 
ONLY If you have trouble getting started playing 

Codename: ICEMAN. 
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A message window will appear after you enter each command. When you have read the 
mes,sage, press [ENTER] to remove the window and resume play. 
The opening of the game fmds our hero, Lt. Commander Johrmy B. Westland lounging on a 
sunny beach in Tahiti enjoying a little well deserved R & R. Next to Johrmy is a table. 
Type look table 
On the table is a magazine. 
Type look magazine 
Type read magazine 
There is an interesting article. 
Type stand up 
Walk left and find volleyball game. 
Type play ball 
Walk into water after girl. 
Follow CPR procedure . 
Walk to front of hotel. 
TyPe open door 
When you are standing inside the hotel lobby, facing the desk: 

Type look 
You will receive a description of the clerk. 
Walk to the center of the room. 'Fum toward the. east wall. 
Type look 
You will receive a description of the door to the cocktail lounge. 
Type look girl 
Type look picture 
Type look pla~t 
Type look flowers 
Johrmy will tum toward each object. 
Type smell flowers 
Johnny will walk to the table and smell the flowers . 
Type talk to clerk 
Johrmy will walk to.the desk: 
Type get key 
Press [Tab] to view inventory. Using your mouse or [Arrow] keys, select KEY and press 
[ENTER]. A picture of your hotel room key will appear. Press [ESC] to resume play. 
Walk to the sign on the north wall. 
Type look sign . 
Walk through the door on the east wall. 
This might be a good time to save your game. 
Walk to the empty bar stool. 
Type sit 
Type talk to girl 
Type buy girl drink 
O.K. Johnny, you're on your own now. Continue exploring the island to discover your mission. 
Good luck! 
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